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Introduction
GDPdU Data Export is a tool that allows you to extract tax-related data from 
Microsoft Dynamics® GP based on the legal requirement of Germany. This data is 
then sent to the auditor for analysis before submitting the final report to the tax 
authorities.

Check for current instructions
This information was current as of May 2010. The documentation may be updated 
as new information becomes available. Check the Microsoft Dynamics GP online 
Web site (http://go.microsoft.com/fwlink/?LinkID=161199) for the most current 
documentation.

The introduction is divided into the following sections:

• What’s in this manual
• Symbols and conventions
• Resources available from the Help menu
• Send us your documentation comments

What’s in this manual

This manual is designed to give you an in-depth understanding of how to use the 
features of GDPdU Data Export, and how it integrates with the Microsoft Dynamics 
GP system.

To make best use of GDPdU Data Export, you should be familiar with systemwide 
features described in the System User’s Guide, the System Setup Guide, and the 
System Administrator’s Guide.

Some features described in the documentation are optional and can be purchased 
through your Microsoft Dynamics GP partner.

To view information about the release of Microsoft Dynamics GP that you’re using 
and which modules or features you are registered to use, choose Help >> About 
Microsoft Dynamics GP.

The manual is divided into the following chapters:

• Chapter 1, “Installation and setup,” describes how to install GDPdU on your 
system. You also can understand how to set up GDPdU tables and fields. You 
can link these tables and fields to generate an SQL query based on which you 
can extract tax relevant data to submit to the auditor.

• Chapter 2, “Inquiries and reports,” explains how to view the table group 
information for database tables. You also can preview the SQL query and 
extract the tax-relevant data to export to the auditor.

http://go.microsoft.com/fwlink/?LinkID=161199


I N T R O D U C T I O N

2 G D P D U D A T A E X P O R T

Symbols and conventions

For definitions of unfamiliar terms, see the glossary in the manual or refer to the 
glossary in Help.

This manual uses the following conventions to refer to sections, navigation and 
other information.

Resources available from the Help menu

The Microsoft Dynamics GP Help menu gives you access to user assistance 
resources on your computer, as well as on the Web.

Contents
Opens the Help file for the active Microsoft Dynamics GP component, and displays 
the main “contents” topic. To browse a more detailed table of contents, click the 
Contents tab above the Help navigation pane. Items in the contents topic and tab 
are arranged by module. If the contents for the active component includes an 
“Additional Help files” topic, click the links to view separate Help files that 
describe additional components.

To find information in Help by using the index or full-text search, click the 
appropriate tab above the navigation pane, and type the keyword to find.

To save the link to a topic in the Help, select a topic and then select the Favorites tab. 
Click Add.

Index
Opens the Help file for the active Microsoft Dynamics GP component, with the 
Index tab active. To find information about a window that’s not currently displayed, 
type the name of the window, and click Display.

About this window
Displays overview information about the current window. To view related topics 
and descriptions of the fields, buttons, and menus for the window, choose the 
appropriate link in the topic. You also can press F1 to display Help about the current 
window.

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts and 
suggestions.

The warning symbol indicates situations you should be 
especially aware of when completing tasks.

Convention Description

Creating a batch Italicized type indicates the name of a section or procedure.

File >> Print or File > 
Print

The (>>) or (>) symbol indicates a sequence of actions, such as 
selecting items from a menu or toolbar, or pressing buttons in 
a window. This example directs you to go to the File menu and 
choose Print.

TAB or ENTER All capital letters indicate a key or a key sequence.
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Lookup
Opens a lookup window, if a window that you are viewing has a lookup window. 
For example, if the Checkbook Maintenance window is open, you can choose this 
item to open the Checkbooks lookup window.

Show Required Fields
Highlights fields that are required to have entries. Required fields must contain 
information before you can save the record and close the window. You can change 
the font color and style used to highlight required fields. On the Microsoft 
Dynamics GP menu, choose User Preferences, and then choose Display.

Printable Manuals
Displays a list of manuals in Adobe Acrobat .pdf format, which you can print or 
view.

What’s New
Provides information about enhancements that were added to Microsoft Dynamics 
GP since the last major release.

Microsoft Dynamics GP Online
Opens a Web page that provides links to a variety of Web-based user assistance 
resources. Access to some items requires registration for a paid support plan.

Current implementation and upgrade information The most recent 
revisions of upgrade and implementation documentation, plus documentation 
for service packs and payroll tax updates.

User documentation and resources The most recent user guides, how-
to articles, and white papers for users.

Developer documentation and resources The most recent 
documentation and updated information for developers.

Product support information Information about the Microsoft Dynamics 
GP product support plans and options that are available, along with 
information about peer support and self-support resources.

Services information Information about Microsoft Dynamics GP support, 
training, and consulting services.

Microsoft Dynamics GP Community Access to newsgroups, where you 
can ask questions or share your expertise with other Microsoft Dynamics GP 
users.

CustomerSource home page A wide range of resources available to 
customers who are registered for a paid support plan. Includes access to 
Knowledge Base articles, software downloads, self-support, and much more.

Customer Feedback Options
Provides information about how you can join the Customer Experience 
Improvement Program to improve the quality, reliability, and performance of 
Microsoft® software and services.
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Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP 
documentation. If you have specific suggestions or find any errors in this manual, 
send your comments by e-mail to the following address: bizdoc@microsoft.com.

To send comments about specific topics from within Help, click the Documentation 
Feedback link, which is located at the bottom of each Help topic.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use 
them freely.

mailto:bizdoc@microsoft.com
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Chapter 1: Installation and setup
Use this information to install and set up GDPdU for use. You also can use this 
information to set up GDPdU tables and GDPdU fields and link them to tables and 
fields in your company database. An SQL query is created based on the table and 
field links. The result of this query is extracted to an Excel® file. The query also 
generates an XML file that contains the information about your table and field 
links.You can send these files to your auditor for analysis before finally submitting 
this information to the legal authorities.

This information is divided into the following sections:

• Installing GDPdU
• GDPdU overview
• Setting up GDPdU definition group
• Setting up the GDPdU database table
• Setting up the GDPdU fields
• Setting up the relation between GDPdU tables
• Adding additional tables to the GDPdU database table
• Selecting fields to link GDPdU database

Installing GDPdU

Use this information to understand how to install GDPdU on your system.

To install GDPdU:
1. Copy the components extracted from the .exe file as specified below: 

• GDPDU.cnk and GDPDU.chm files to your <target> folder, and 
GDPDU.pdf to the Documentation folder in your <target> folder. (<target> 
is your Microsoft Dynamics GP install folder). 

• Document type definition file to an appropriate location.

2. Launch Microsoft Dynamics GP.

3. Choose Yes to include the new code and log in as the user 'sa'.

4. GDPdU is now ready to use. 

GDPdU overview

The Principles of data access and auditing of digital documents feature is also 
referred to as GDPdU. It requires each company to submit all tax-related data in 
electronic format to the auditor for analysis. The auditor analyses the data and 
submits the final report to the tax authorities.

There are three different methods to export the data to the auditor as specified by 
the legal authorities:

• Direct access.
• Indirect access.
• Surrender of data media.
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GDPdU allows you to export the data using the method of surrender of data media. 
To extract the required data to export from your Microsoft Dynamics GP database, 
you must define a GDPdU group and set up GDPdU table IDs and field IDs for each 
group. You must link each GDPdU table to a database table. You can link the 
database table to other database tables. You can preview the SQL query that is 
generated once you have linked all the necessary tables and fields. The result of this 
query is extracted to an Excel file and an XML file, which you can send to your 
auditor for analysis.

Use the following flowchart to understand the set up process for GDPdU.
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Setting up GDPdU definition group

You can use the GDPdU Definition Group Setup window to set up the GDPdU 
definition group ID. You can create the GDPdU tables IDs for the definition group 
you have set up.

To set up GDPdU definition group:
1.  Open the GDPdU Definition Group Setup window.

(Microsoft Dynamics GP menu >> Tools >> Utilities >> Company >> 
GDPdU >> GDPdU Definition Group)

2.  Enter a definition group ID.

3. Enter the description for the definition group ID.

4. Enter the GDPdU table name for which to generate the data and its description 
in the scrolling window.

5. Enter a name for the GDPdU export file.

6. Choose the Database Table button to open the GDPdU Database Table Setup 
window where you can select the database tables to extract data from.

7. Choose the Table Relation button to open the GDPdU Table Relation Setup 
window where you can link GDPdU field IDs from one GDPdU table to another 
GDPdU table belonging to the same group.

Setting up the GDPdU database table

Use the GDPdU Database Table Setup window to link a GDPdU table ID to a table 
in your company database.
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To set up the GDPdU database table:
1. Open the GDPdU Database Table Setup window.

(Microsoft Dynamics GP menu >> Tools >> Utilities >> Company >> 
GDPdU >> GDPdU Definition Group >> Database Table button) OR
(Microsoft Dynamics GP menu >> Tools >> Utilities >> Company >> 
GDPdU >> GDPdU Database Table)

2. Enter or select the definition group ID.

3. Select the GDPdU database table ID.

The Description and File name fields display description and file name for the 
selected GDPdU table ID respectively.

4. Select a product in the Product field to select the database tables.

5. Select the series in the Series field to select the database tables. The Tables List 
scrolling window displays the table list for the selected criteria.

6. Select the table in the Tables List scrolling window to use as the primary table 
for the selected GDPdU table ID.

7. Select a table in the Tables List, and choose insert to add it to the Selected Tables 
list.

8. Choose Remove to remove the selected table from the Selected Tables list.

9. Choose Remove All to remove all tables from the Selected Tables list. 

10. Choose Table Group Info to open the Table Group Information window where 
you can view the table group that a table belongs to.

11. Choose Add Table to open the Add Table window where you can select the 
additional tables to link to tables in the Selected Tables column.
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12. Choose Field Setup to open the GDPdU Field Setup window, where you can set 
up fields for each GDPdU table ID and link each field to a database field.

13. Choose Save to save your setup.

14. Choose Query Preview to open the Query Preview window, in which you can 
view the SQL query that is created based on the table and field links.

15. Choose Clear to clear the values displayed in the window.

16. Choose Delete to delete all the setups done for the selected GDPdU table ID.

Setting up the GDPdU fields

You can use the GDPdU Field Setup window to set up GDPdU field IDs and link 
them with fields from database tables.

To set up the GDPdU fields:
1. Open the GDPdU Field Setup window

(Microsoft Dynamics GP menu >> Tools >> Utilities >> Company >> 
GDPdU >> GDPdU Database Table >> Field Setup button)

The definition group ID, GDPdU table and its description is displayed from the 
GDPdU Database Table Setup window.

2. Enter the GDPdU field ID.

3. Enter a description for the field.

4. Select a database table in the Table field. The tables you selected in the GDPdU 
Database Table Setup window are available for selection.

5. Select a field from the selected database table to assign to the GDPdU field ID.

6. Mark the Primary Key check box to consider a field as the primary key.

7. Mark the Validity Period check box to filter the tax-related data based on this 
field. This option is available only for date fields.

8. Choose Move Up to move the selected row up by one line.
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9. Choose Move Down to move the selected row down by one line.

10. Choose Cancel to close the window without saving the changes.

11. Choose OK to save your settings and return to the GDPdU Database Table 
Setup window.

Setting up the relation between GDPdU tables

You can use a GDPdU field ID to link one GDPdU table ID to another if both the 
tables belong to the same GDPdU group.

To set up the relation between GDPdU tables:
1. Open the GDPdU Table Relation Setup window.

(Microsoft Dynamics GP menu >> Tools >> Utilities >> Company >> GDPdU 
>> GDPdU Definition Group >> Table Relation button) OR
(Microsoft Dynamics GP menu >> Tools >> Utilities >> Company >> 
GDPdU >> GDPdU Table Relation)

2. Enter or select a definition group ID.

3. Enter or select the GDPdU table ID for the selected definition group ID. The 
table description is also displayed.

4. Enter or select the GDPdU field ID to link to the related GDPdU table ID.

5. Enter or select the GDPdU table ID for which to link the selected GDPdU field 
ID.

6. Choose OK to save the relation or Cancel to close the window.

Adding additional tables to the GDPdU database table

You can use the Add Table window to link additional tables to the table you have 
selected in the GDPdU Database Table Setup window.
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To add additional tables to the GDPdU database table:
1. Open the Add Table window.

(Microsoft Dynamics GP menu >> Tools >> Utilities >> Company >> 
GDPdU >> GDPdU Database Table >> Add Table button)

The Table field displays the primary table selected in the GDPdU Database 
Table Setup window.

2. Select the product and the series from which to choose the table to be linked.

3. Select the additional table in the Link Table field to link to the table selected in 
the GDPdU Database Table Setup window. The scrolling window displays the 
fields that are linked.

4. Choose Add Link to open the Add Link window where you can select the fields 
to link the tables.

5. Choose OK to save the changes and close the window.

6. Choose Cancel to close the window without saving the changes.

Selecting fields to link GDPdU database

You can use the Add Link window to select the fields to link related GDPdU tables.

To select fields to link GDPdU database tables:
1. Open the Add Link window.

(Microsoft Dynamics GP menu >> Tools >> Utilities >> Company >> 
GDPdU >> GDPdU Database Table >> Add Table button >> Add Link button)

2. Select a field from the From table.
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3. Select the field from the To table to link to the field you selected from the From 
table.

4. Choose OK to save the settings.

5. Choose Cancel to close the window.
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Chapter 2: Inquiries and reports
Use this information to view the technical information for database tables in a table 
group. You also can view the SQL query that is created when you set up the GDPdU 
tables and link related tables to extract the required financial data. You can export 
this data to an Excel file to be sent to the auditors for analysis.

This information is divided into the following sections:

• Viewing the technical information of tables linked to a table group
• Previewing the SQL query
• Exporting the GDPdU data to an electronic media

Viewing the technical information of tables linked to a 
table group

You can use the Table Group Information window to view and print technical 
names, display names and physical names of database tables in a table group. You 
can use this information to link related tables to extract tax-related data.

To view the technical information of tables linked to a 
table group:
1. Open the Table Group Information window.

(Microsoft Dynamics GP menu >> Tools >> Utilities >> Company >> 
GDPdU >> GDPdU Database Table >> Table Group Info. button)

2. Select the product to view the table information for.

3. Select the series to view the table information for.

4. Select a table in the Table field to view the table group it belongs to .The Table 
Group field displays the table group that the selected table belongs to.
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5. Select a table group in the Table Group field to view the list of tables that belong 
to that group.

6. The Table List scrolling window displays the technical name, display name and 
physical name of all the tables that belong to the selected group.

7. Choose OK to close the window.

8. Choose Clear to clear the values displayed in the window. 

Previewing the SQL query

You can use the Query Preview window to view the SQL query generated based on 
the GDPdU table setups and the relation you have created between GDPdU tables 
and the database tables.

To preview the SQL query:
1. Open the Query Preview window.

(Microsoft Dynamics GP menu >> Tools >> Utilities >> Company >> 
GDPdU >> GDPdU Database Table >> Query Preview button)

The window displays the SQL query and the definition group for which the 
SQL query is generated.

Exporting the GDPdU data to an electronic media

You can use the GDPdU data export wizard to export the extracted financial data to 
an Excel file, which can then be copied to the electronic medium and sent to the 
auditor.
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To export the GDPdU data to an electronic media:
1. Open the GDPdU Data Export Wizard – Welcome window.

(Microsoft Dynamics GP menu >> Tools >> Utilities >> Company >> 
GDPdU >> GDPdU Data Export)

2. Choose Next to open the GDPdU Data Export Wizard – Choose GDPdU 
Definition Group window.

3. Select the definition group ID to export. The description for the definition group 
is also displayed.

4. In Select the base for export field, select whether to export data for a year or for 
a date range.

5. Enter the date range in the From and To fields to export the data. These fields 
are available if you have selected to filter the data using the date range option.

6. Select the year for which to export the data. This field is available if you have 
selected to filter the data using the year option.

7. Choose Database Table to open the GDPdU Database Table Setup window to 
view the GDPdU table setup information. You can modify this information if 
required.
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8. Choose Next to open the GDPdU Data Export Wizard – Export Information 
window.

9. Enter a version for the export data in the Data Version field to include in the 
XML file.

10. Enter a comment to include in the XML file.

11. Select the GDPdU version to include in the XML file.

12. Select the GDPdU document type definition file (.dtd file). Refer to Installing 
GDPdU on page 5 for more information.

13. Select the location to export the data file in the Export Path field.

14. Select the export file format. The available options are Text and CSV.

15. Enter the folder name to export the data files to in the Name of Data Media 
field. 

16. Enter the size of the data media in bytes to export in the Capacity of Data Media 
field.

17. Enter the size of the XML file in bytes in the Expected XML File Length field.
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18. Choose Next to open the GDPdU Data Export Wizard – Completing the 
GDPdU Data Export wizard.

19. Choose Back to return to the previous window in the wizard.

20. Choose Finish to export the data file to the location specified.

21. Choose Cancel to close the wizard without exporting the data file.
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Glossary
Database table

The logical structure created in the database 
that stores relevant data.

GDPdU definition group
A set of GDPdU tables.

GDPdU field
The column name in the export file in which 
related field information is printed.

GDPdU table
The relationship between different database 
tables.
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Index
A
Add Link window, displaying 11
Add Table window, displaying 11

C
changes since last release, information 

about 3
current upgrade information, accessing on 
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Completing the GDPdU Data Export 
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GDPdU database table, adding additional 
tables 10

GDPdU Database Table Setup window, 
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